DTP CrossPoint 4K Series
Scaling Presentation Matrix Switcher

IMPORTANT:
Go to www.extron.com for the complete user guide, installation instructions, and specifications.
**Safety Instructions • English**

**WARNING:** This symbol, ¤, when used on the product, is intended to alert the user of the presence of uninsulated dangerous voltage within the product’s enclosure that may present a risk of electric shock.

**ATTENTION:** This symbol, Ѳ, when used on the product, is intended to alert the user of important operating and maintenance (servicing) instructions in the literature provided with the equipment.


**Instrucciones de seguridad • Español**

**ADVERTENCIA:** Este símbolo, ¤, cuando se utiliza en el producto, avisa al usuario de la presencia de voltaje peligroso sin aislar dentro del producto, lo que puede representar un riesgo de descarga eléctrica.

**ATENCIÓN:** Este símbolo, Ѳ, cuando se utiliza en el producto, avisa al usuario de la presencia de importantes instrucciones de uso y mantenimiento recogidas en la documentación proporcionada con el equipo.


**Инструкция по технике безопасности • Русский**

**ПРЕДУПРЕЖДЕНИЕ:** Данный символ, ¤, если указан на продукте, предупреждает пользователя о наличии некондиционированного опасного напряжения внутри корпуса продукта, которое может привести к поражению электрическим током.

**ВНИМАНИЕ:** Данный символ, Ѳ, если указан на продукте, предупреждает пользователя о наличии важных инструкций по эксплуатации и обслуживанию в руководстве, прилагаемом к данному оборудованию.

Для получения информации о правилах техники безопасности, соблюдении нормативных требований, электромагнитной совместимости (ЭМП/ЭДС), возможности доступа и других вопросах см. руководство по безопасности и соблюдению нормативных требований Extron на сайте Extron: www.extron.com, номер по каталогу - 68-290-01.

**Safety Instructions • English**

**WARNING:** This symbol, ¤, when used on the product, is intended to alert the user of the presence of uninsulated dangerous voltage within the product’s enclosure that may present a risk of electric shock.

**ATTENTION:** This symbol, Ѳ, when used on the product, is intended to alert the user of important operating and maintenance (servicing) instructions in the literature provided with the equipment.

FCC Class A Notice

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC rules. The Class A limits provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause interference. This interference must be corrected at the expense of the user.

**ATTENTION:** The Twisted Pair Extension technology works with unshielded twisted pair (UTP) or shielded twisted pair (STP) cables; but, to ensure FCC Class A and CE compliance, STP cables and STP Connectors are required.

For more information on safety guidelines, regulatory compliances, EMI/EMF compatibility, accessibility, and related topics, see the “Extron Safety and Regulatory Compliance Guide” on the Extron website.

Battery Notice

This product contains a battery. **Do not open the unit to replace the battery.** If the battery needs replacing, return the entire unit to Extron (for the correct address, see the Extron Warranty section on the last page of this guide).

**CAUTION:** Risk of explosion. Do not replace the battery with an incorrect type. Dispose of used batteries according to the instructions.

**ATTENTION:** Risque d’explosion. Ne pas remplacer la pile par le mauvais type de pile. Débarrassez-vous des piles usagées selon le mode d’emploi.
Conventions Used in this Guide

Notifications

ATTENTION:  
• Risk of property damage.  
• Risque de dommages matériels.

NOTE:  A note draws attention to important information.

TIP:  A tip provides a suggestion to make working with the application easier.

Software Commands

Commands are written in the fonts shown here:

```
^AR Merge Scene,,Op1 scene 1,1 ^B 51 ^W ^C
[01] R0004 0030 000400 0080 00600 [02] 35 [17] [03]
```

```
Esc [X1] * [X17] * [X20] * [X23] * [X21] CE ←
```

NOTE:  For commands and examples of computer or device responses mentioned in this guide, the character “0” is used for the number zero and “O” is the capital letter “o.”

Computer responses and directory paths that do not have variables are written in the font shown here:

```
Reply from 208.132.180.48: bytes=32 times=2ms TTL=32
C:\Program Files\Extron
```

Variables are written in slanted form as shown here:

```
ping xxx.xxx.xxx.xxx -t
```

```
SOH R Data STX Command ETB ETX
```

Selectable items, such as menu names, menu options, buttons, tabs, and field names are written in the font shown here:

```
From the File menu, select New.
```

```
Click the OK button.
```

Specifications Availability

Copyright
© 2015 Extron Electronics. All rights reserved.

Trademarks
All trademarks mentioned in this guide are the properties of their respective owners. The following registered trademarks, registered service marks, and trademarks are the property of RGB Systems, Inc. or Extron Electronics:

<table>
<thead>
<tr>
<th>Registered Trademarks</th>
<th>Registered Service Mark</th>
<th>Trademarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>AVTrac, Cable Cubby, CrossPoint, eBUS, EDID Manager, EDID Minder, Extron, Flat Field, FlexOS, Global Configurator, GlobalViewer, Hideaway, Inline, IP Intercom, IP Link, Key Minder, LockIt, MediaLink, PlenumVault, PoleVault, PowerCage, PURE3, Quantum, SoundField, SpeedMount, SpeedSwitch, System INTEGRATOR, TeamWork, TouchLink, V-Lock, VersaTools, VN-Matrix, VoiceLift, WallVault, WindoWall, XTP and XTP Systems</td>
<td>S3 Service Support Solutions</td>
<td>AAP, AFL (Accu-Rate Frame Lock), ADSP (Advanced Digital Sync Processing), Auto-Image, CableCover, CDRS (Class D Ripple Suppression), DDSP (Digital Display Sync Processing), DMI (Dynamic Motion Interpolation), Driver Configurator, DSP Configurator, DSVP (Digital Sync Validation Processing), DTP, eLink, EQIP, FastBite, FOX, FOXBOX, IP Intercom HelpDesk, LinkLicense, MAAP, MicroDigital, NetPa, ProDSP, QS-FPC (QuickSwitch Front Panel Controller), Room Agent, Scope-Trigger, ShareLink, SIS, Simple Instruction Set, Skew-Free, SpeedNav, Triple-Action Switching, True4K, Vector, WebShare, XTRA, ZipCaddy, ZipClip</td>
</tr>
</tbody>
</table>
## Contents

### Introduction ............................. 1
   About this Guide ....................... 1
   About the DTP CrossPoint 4K Series ........................................... 1
   DTP Input and Output Signals .......... 3

### Installation ............................. 4
   Rear Panel ................................ 4
   Video Inputs and Outputs .......... 4
   Audio Inputs and Outputs .......... 7
   Serial and IR Insertion
      Connections ............................ 8
   Control Connections .................. 9
   Switcher Reset ......................... 10
   Power .................................... 10
   Additional Connector
      Information ............................ 10
   Front Panel ................................ 16

### Front Panel Operations .......... 17
   Creating a Tie ........................... 17
   Recalling a Preset ...................... 18
   Viewing Ties (and Muting Outputs) ...................... 18
   Assigning a Logo to an Output ... 19
   Viewing and Adjusting Volume
      and Mic Volume ...................... 19
   Setting the Front Panel Locks
      (Executive Modes) ................... 20
      Selecting Lock Mode 2 or
         Toggling between Mode 2
         and Mode 0 ....................... 21
      Selecting Lock Mode 2 or
         Toggling between Mode 2
         and Mode 1 ....................... 21

### Remote Control ...................... 22
   Selected SIS Commands ............... 22
      Establishing a Network
         (Ethernet) Connection ............. 22
      Number of Connections ............. 23
      Establishing a USB Port
         Connection .......................... 23
      Host-to-Switcher
         Instructions ........................ 23
      Common SIS Command
         Symbols ............................. 23
      SIS Command and Response
         Table for Matrix Switcher
         Commands .......................... 24
   Installing and Starting the
      Control Programs ..................... 28
      Installing the programs ............. 28
      Starting the Product
         Configuration Software ............. 30
      Starting the DSP Configurator
         Program ............................ 31
   Accessing the HTML Pages .......... 32
Introduction

This section gives an overview of the Extron DTP CrossPoint 4K Series matrix switchers and describes their features. Topics that are covered include:

- About this Guide
- About the DTP CrossPoint 4K Series

About this Guide


This guide provides instructions for an experienced installer to set up and operate the Extron DTP CrossPoint 4K Series matrix switchers. Step by step instructions show you how to:

- Connect the hardware (see Rear Panel on page 4)
- Perform basic operations from the front panel (see Front Panel Operations on page 17)
- Use selected SIS commands (see SIS Command and Response Table for Matrix Switcher Commands on page 24)
- Load and start the control programs (see Starting the Product Configuration Software on page 30 and Starting the DSP Configurator Program on page 31)
- Connect to the built-in HTML pages (see Accessing the HTML pages, on page 32)

About the DTP CrossPoint 4K Series

The matrix switchers distribute HDCP-compliant HDMI and Extron proprietary DTP video and audio signal types. A matrix switcher routes any input signal to any combination of outputs. It can route multiple input and output configurations simultaneously.

The DTP CrossPoint 4K Series consists of three 10-input by 8-output models. Outputs 5 through 8 are scalable. The three models are differentiated by their audio and control capabilities:

- **DTP CrossPoint 108 4K** — 10x8 DTP matrix switcher
- **DTP CrossPoint 108 4K IPCP SA** — Includes a stereo audio amplifier and a built-in Extron IPCP Pro 350 control processor
- **DTP CrossPoint 108 4K IPCP MA** — Includes a 70 V mono audio amplifier and a built-in Extron IPCP Pro 350 control processor
Figure 1. Typical DTP CrossPoint Application

The switchers provide four mono microphone (mic)/line level inputs that can be mixed with or across one or all audio outputs.

The IPPC models also feature the built-in Extron IPPC Pro 350 control processor, which has local area network (LAN) Ethernet ports, RS-232 and IR-based control, relays, and digital I/O controls that can control and monitor a variety of external devices, such as projectors and lights. The non-IPPC model has one Ethernet port.

The matrix switcher can be remotely controlled via an Ethernet LAN port, a serial port, or a USB port connection using either the Extron Product Configuration Software, DSP Configurator software, or the Simple Instruction Set (SIS).
DTP Input and Output Signals

The DTP inputs and outputs are proprietary signals that are created within any of the Extron DTP Extenders systems and transmitted over a single shielded twisted pair (STP) cable.

The DTP CrossPoint accepts DTP inputs from transmitting devices such as the DTP T USW 333. Depending on the connected transmitting model, it generates the DTP signal from a variety of video and audio inputs, including HDMI, DVI, analog VGA, and embedded and analog audio. The DTP signal can also include bidirectional RS-232 and IR control signals from the connected transmitting and receiving devices or inserted locally, on the DTP CrossPoint switcher.

Depending on the technology of the transmitting or receiving device, DTP 330 or DTP 230, the TP inputs and outputs can travel up to 330 feet (100 meters) or 230 feet (70 meters) without a loss of signal integrity.
Installation

This section describes installation of the DTP CrossPoint 4K Series including connections and features. Topics that are covered include:

- Rear Panel
- Front Panel

Rear Panel

**ATTENTION:**
- Remove system power before making all connections.
- Débranchez l’alimentation du système avant de faire n’importe quelle connexion.


Video Inputs and Outputs

A HDMI inputs (see the next page)
B TP (XTP/DTP) switches (see the next page)
C TP inputs (see the next page)
D HDMI outputs (see the next page)
E TP (XTP/HDBT/DTP) switches (see page 6)
F TP outputs (see page 6)
A **HDMI inputs 1 through 6** — Plug HDMI digital video (or DVI with appropriate adapters) into these HDMI ports. See **HDMI connectors** on page 10 to secure the connector to the enclosure with a LockIt HDMI Cable Lacing Bracket.

B **TP (XTP/DTP) switches, inputs 7 through 10** —

**ATTENTION:**
- Position this switch **BEFORE** connecting the appropriate device to the TP connector. Failure to comply can damage the endpoint.
- Positionnez le sélecteur **AVANT** de connecter l’appareil approprié au connecteur TP. Ne pas respecter cette procédure pourrait endommager le point de connexion.

**XTP position** — Select if the transmitting device is an Extron XTP matrix switcher. The input consists of HDMI with embedded audio plus RS-232 and IR.

**DTP position** — Select if the transmitting device is an Extron DTP device. The input consists of HDMI with embedded audio, analog audio, and RS-232 and IR. The switcher can provide remote power to the transmitter.

C **TP Inputs 7 through 10** — Plug compatible Extron DTP or XTP signals into these RJ-45 ports using STP cables. See **TP connectors** on page 11 to wire the connectors.

**ATTENTION:**
- Do not connect this port to a computer data or telecommunications network.
- Ne connectez pas ces port à des données informatiques ou à un réseau de télécommunications.

D **HDMI outputs 1 through 5a, 6a** — Plug HDMI video displays (or DVI with appropriate adapters) into these ports. See **HDMI connectors** to secure the connectors to the enclosure with a LockIt HDMI Cable Lacing Bracket.

**NOTE:** The signal output on HDMI outputs 5a and 6a is duplicated on TP outputs 5b and 6b.
TP (XTP/HDBT/DTP) switches, outputs 5 through 8

**ATTENTION:**

- Position this switch **BEFORE** connecting the appropriate device to the TP connector. Failure to comply can damage the endpoint.
- Positionnez le sélecteur **AVANT** de connecter l’appareil approprié au connecteur TP. Ne pas respecter cette procédure pourrait endommager le point de connexion.

**XTP position** — Select if the receiving device is an Extron XTP matrix switcher. The TP output consists of HDMI with embedded audio plus RS-232 and IR.

**HDBT position** — Select if the receiving device is a HDBaseT-enabled device. The TP output consists of HDMI with embedded audio plus RS-232 and IR.

**DTP position** — Select if the receiving device is an Extron DTP device. The TP output consists of HDMI with embedded audio, analog audio, RS-232 and IR, and remote power.

**TP outputs 5b, 6b, 7, and 8** — Plug compatible Extron DTP receivers, XTP matrix switchers, or HDBaseT-enabled devices into these RJ-45 ports using STP cables. See **TP connectors** on page 11 to wire the connector.

**NOTE:** The video and embedded signal output on TP outputs 5b and 6b is duplicated on HDMI outputs 5a and 6a.
Audio Inputs and Outputs

Figure 3. Audio Input and Output Features

G Audio inputs 1 through 6 — Plug balanced or unbalanced stereo audio inputs into these 3.5 mm, 5-pole captive screw connectors (see Local and Mic/Line audio connectors on page 14 to wire the connectors).

H Mic/Line inputs 1 through 4 — Plug microphones or other mono audio sources into these 3.5 mm, 3-pole captive screw connectors (see Local and Mic/Line audio connectors to wire the connectors).

I +48 V (phantom power) LEDs — Light to indicate +48 V phantom power is switched on via software.

J Audio outputs 1 through 4 — Plug audio devices such as an audio amplifier or powered speakers to these 3.5 mm, 5-pole captive screw connectors (see Local and Mic/Line audio connectors to wire the connectors).

K Amp output 1 (SA [stereo] model) — Plug passive, 4 ohm or 8 ohm speakers to this 5 mm, 4-pole captive screw connector to receive the amplified audio from output 1.

L Amp output 1 (MA [mono] model) — Plug passive high-impedance speakers to this 2-pole captive screw connector to receive the amplified audio from output 1.

M S/PDIF output 6 — Plug a compatible device into this RCA connector with a 75 ohm digital audio cable to receive a digital audio signal from the output 6 digital stream.

N DMP Expansion port and LED —

Expansion Port — Plug an STP cable between this port and the Expansion port on an optional Extron DMP 128 ProDSP Digital Matrix Processor.

Link LED — Lights to indicate that the port is connected to a compatible device.
Figure 4. Serial and IR Insertion Connections

- Over TP ports (inputs 7 through 10) — Plug serial RS-232 signals, modulated IR signals, or both into these 3.5 mm, 5-pole captive screw connectors to insert bidirectional RS-232 and IR communications. See RS-232 and IR connectors on page 15 to wire the connectors.

- Over TP ports (outputs 5B, 6B, 7, and 8) — Plug serial RS-232 signals, modulated IR signals, or both into these 3.5 mm, 5-pole captive screw connectors to insert bidirectional RS-232 and IR communications. See RS-232 and IR connectors to wire the connectors.
Control Connections

Figure 5.  IPCP Control Processor and Remote Port

NOTE: Figure 5 shows features for all models. Actual models can have either a LAN port (item Q) or a control processor (item R), but not both.

Q LAN (Ethernet) port (non-IPCP model) — If desired, connect a network WAN or LAN hub, a control system, or a computer to the Ethernet RJ-45 port (see TP connectors on page 11 to wire the connector).

NOTE: The factory default IP address is 192.168.254.254.

R IPCP control processor (IPCP models) — The IPCP models include a built-in control processor that can control and monitor a variety of external devices. The IPCP offers RS-232 and IR-based control, relays, and digital I/O controls. See the IPCP Pro Series Setup Guide, included with the switcher, to make all connections and to configure and operate the IPCP control processor.

S Remote port — Plug a serial RS-232 device into the matrix switcher via this 3.5 mm, 3-pole captive screw connector for remote control of the switcher (see RS-232 and IR connectors on page 15 to wire the connector).
Swicher Reset

Figure 6. Reset button and LED

Switcher Reset button and LED — Initiates four levels of matrix switcher reset. For different reset levels, press and hold the recessed Reset button while the switcher is running or while you power up the switcher.


Power

Figure 7. Power connector

Power connector — Plug the switcher into a grounded AC source.

Additional Connector Information

HDMI connectors

Use a LockIt Lacing Bracket to securely fasten each HDMI cable to the switcher as follows:

1. Plug the HDMI cable into the panel connection (see figure 8, 1, on the next page).

2. Loosen the HDMI connection mounting screw from the panel enough to allow the LockIt Lacing Bracket to be placed over it (2). The screw does not have to be removed.

3. Place the LockIt Lacing Bracket on the screw and against the HDMI connector (3), and then tighten the screw to secure the bracket.
ATTENTION:
• Do not overtighten the HDMI connector mounting screw. The shield it fastens to is very thin and can easily be stripped.
• Ne serrez pas trop la vis de montage du connecteur HDMI. Le blindage auquel elle est attachée est très fin et peut facilement être dénudé

4. Loosely place the included tie wrap around the HDMI connector and the LockIt Lacing Bracket (see figure 8, 4).

5. While holding the connector securely against the lacing bracket, use pliers or a similar tool to tighten the tie wrap (5), and then remove any excess length.

**TP connectors**

All RJ-45 ports, whether DTP ports, the Expansion port, and the LAN (Ethernet) ports on the switcher or IPCP control processor use twisted pair cables (see figure 9 on the next page).

- **Patch (straight) cable** —
  - **DTP input and output ports** — Shielded twisted pair (STP) for connection to Extron DTP transmitters and receivers, XTP matrix switchers, or HDBaseT-enabled devices.
  - **Expansion port** — STP for connection between the matrix switcher and a DMP 128. A shielded 1-foot cable is included with the DMP 128.
  - **LAN ports** — Unshielded twisted pair (UTP) or STP for connection of the LAN port to an Ethernet LAN.

- **Crossover cable** (see figure 9) —
  - **LAN ports** — UTP or STP for direct connection between the DTP CrossPoint 4K Series and a connected computer.
A cable that is wired as T568A at one end and T568B at the other (Tx and Rx pairs reversed) is a "crossover" cable.

A cable that is wired the same at both ends is called a "straight-through" cable, because no pin/pair assignments are swapped.

**NOTES:**
- Do not use standard telephone cables. Telephone cables do not support Ethernet or Fast Ethernet.
- Do not stretch or bend cables. Transmission errors can occur.

**LAN ports**

The LAN ports require Category (CAT) 3, CAT 5e, or CAT 6a unshielded twisted pair (UTP) or shielded twisted pair (STP) cables, crossover or patch cables.

The cable used depends on your network speed. The switcher LAN port supports both 10 Mbps (10Base-T — Ethernet) and 100 Mbps (100Base-T — Fast Ethernet), half-duplex and full-duplex Ethernet connections.

- 10Base-T Ethernet requires CAT 3 UTP or STP cable at minimum.
- 100Base-T Fast Ethernet requires CAT 5e UTP or STP cable at minimum.

For ports on an IPCP module, see the *IPCP Pro Series User Guide* at [www.extron.com](http://www.extron.com) to make all network connections and to configure and operate the IPCP control processor.

**DTP and Expansion ports**

The DTP input and output ports are compatible with Extron XTP DTP 24 SF/UTP cables or shielded twisted pair (F/UTP, SF/UTP, and S/FTP) cable. The Expansion port requires CAT 5e, 6, 6a, or 7 shielded twisted pair cable.
For the Expansion port only —

**ATTENTION:**

- Connect this port to the Expansion port on a compatible Extron DMP processor. **Do NOT** connect this port to a LAN or Power over Ethernet port; equipment damage can occur.
- Connectez ce port au port d’expansion sur un processeur DMP d’Extron compatible. Ne connectez **PAS** ce port à un port LAN ou d’alimentation via Ethernet ; le matériel pourrait être endommagé.

For the DTP ports only —

Extron recommends the following practices to achieve full transmission distances up to 330 feet (100 m) and reduce transmission errors.

Use the following Extron XTP DTP 24 SF/UTP cables and connectors for the best performance:

- **XTP DTP 24/1000** Non-Plenum 1000' (305 m) spool 22-236-03
- **XTP DTP 24P/1000** Plenum 1000' (305 m) spool 22-235-03
- **XTP DTP 24 Plug** Package of 10 101-005-02

**ATTENTION:**

- Do not connect these boards to a computer data or telecommunications network.
- Ne connectez pas ces port à des données informatiques ou à un réseau de télécommunications.

- Do not use Extron UTP23SF-4 Enhanced Skew-Free AV UTP cable or STP201 cable to link the matrix switcher to Extron DTP products, XTP matrix switchers, or HDBaseT-enabled devices.
- N’utilisez pas le câble AV Skew-Free UTP version améliorée UTP23SF-4 ou le câble STP201 pour relier la grille de commutation aux produits DTP, aux grilles de commutation XTP ou aux appareils équipés HDBaseT Extron.

- To ensure FCC Class A and CE compliance, STP cables and STP connectors are required.
- Afin de s’assurer de la compatibilité entre FCC Classe A et CE, les câbles STP et les connecteurs STP sont nécessaires.
NOTE: When using cable in bundles or conduits, consider the following:

- Do not exceed 40% fill capacity in conduits.
- Do not comb the cable for the first 20 meters, where cables are straightened, aligned, and secured in tight bundles.
- Loosely place cables and limit the use of tie wraps or hook and loop fasteners.
- Separate twisted pair cables from AC power cables.

Local and Mic/Line audio connectors

Use the supplied tie-wrap to strap the audio cable to the extended tail of the connector.

ATTENTION:

- For unbalanced audio output, connect the sleeves to the ground contact. **DO NOT** connect the sleeves to the negative (-) contacts.
- Connectez ce port au port d’expansion sur un processeur DMP d’Extron compatible. Ne connectez **PAS** ce port à un port LAN ou d’alimentation via Ethernet ; le matériel pourrait être endommagé.
NOTES:
- The length of exposed wires is important. The ideal length is 3/16 inch (5 mm).
- If the stripped section of wire is longer than 3/16 inch, the exposed wires may touch, causing a short circuit.
- If the stripped section of wire is shorter than 3/16 inch, wires can be easily pulled out even if tightly fastened.
- Do not tin the power supply leads. Tinned wires are not as secure in the connector and could be pulled out.

RS-232 and IR connectors

Figure 11 shows how to wire the RS-232 and IR connector.

NOTE: The length of exposed wires is important (see the audio connectors NOTES above for more information).
Figure 12. Front Panel Configuration Port

**Configuration port** — This USB mini-B port serves a similar communications function as the rear panel Remote port, but it is easier to access than the rear port after the matrix switcher has been installed and cabled.

**NOTE:** A front panel Configuration port connection and a rear panel Remote port connection can both be active at the same time. If commands are sent simultaneously to both, the command that reaches the processor first is handled first.
Front Panel Operations

This section describes simple DTP CrossPoint matrix switcher operation from the front panel. Topics that are covered include:

- Creating a Tie
- Recalling a Preset
- Viewing Ties
- Assigning a Logo to an Output
- Viewing and Adjusting Volume and Mic Volume
- Setting the Front Panel Locks (Executive Modes)

Creating a Tie

NOTES:
- "Tie" is an input-to-output connection.
- "Set of ties" is an input tied to two or more outputs. (An output can never be tied to more than one input.)
- "Configuration" is one or more ties, one or more sets of ties, or a combination.

1. Press and release the Esc button to clear any input button, output button, or control button indicators that may be lit.
2. Press and release the Video and Audio I/O buttons to select or deselect video, audio, or both as desired.
   - Green when selected
   - Off when deselected
   - Red when selected
   - Off when deselected
   
   NOTE: Audio or video can be broken away (tied by itself) by selecting only the Video button or only the Audio button.
3. Press and release the desired input button.
   The button lights to indicate the selection.
4. Press and release the desired output buttons.

   *Amber* indicates **video** and **audio** tie.
   *Green* indicates **video** only tie.
   *Red* indicates **audio** only tie.

5. Press and release the **Enter** button. All button indicators turn off.

**Recalling a Preset**

A "preset" is a configuration that has been stored. Presets 1 through 18 are selectable from the front panel, using the input and output buttons.

1. Press and release the **Preset** button.

   The Preset button lights. Press and release. All input and output buttons with assigned presets light **red**.

2. Press and release the input or output button for the desired preset.

   The button blinks **red** to indicate that this **preset** is selected to recall.

   The Enter button blinks **red** to indicate the need to activate the recall.

3. Press and release the **Enter** button.

**Viewing Ties**

1. Press the **View** button. Output buttons light for outputs that have no ties established.

2. Press an input button. The buttons for all tied outputs light.

3. Press an output button. The buttons for the tied input and all tied outputs light.

4. Press the **View** button again to exit View mode. All inputs and output buttons return to an unlit state.
Assigning a Logo to an Output

The switcher can display a logo on one or more of outputs 5 through 8.

NOTES:
- The switcher has memory space for 16 bit-mapped logo files; 3 are stored in the switcher as shipped from the factory.

1. Preset and release the Logo Select button.

   The button lights.

   Press and release.

   Lit input buttons identify saved logo files.

2. Press and release the input button for the desired logo file.

   The button blinks to indicate the selection.

3. Press and release one or more output buttons to assign the logo to those outputs.

   The buttons indicate the selection.

4. Press and release the Enter button.

Viewing and Adjusting Volume and Mic Volume

Rotate the applicable knob clockwise to increase the program volume or mic volume. Rotate the knob counterclockwise to decrease volume.

The LED ladder indicates the approximate volume; the more LEDs are lit, the higher the volume.
Setting the Front Panel Locks (Executive Modes)

The matrix switcher has three levels of front panel security lock that limit the operation of the switcher from the front panel. The three levels are:

- **Lock mode 0** — The front panel is completely unlocked.
- **Lock mode 1** — All functions are locked from the front panel (except for setting Lock mode 2). Some functions can be viewed.
- **Lock mode 2** — Basic functions are unlocked. Advanced functions are locked and can be viewed only.

The *basic* functions covered in this guide consist of:

- Making ties
- Recalling presets
- Setting audio volume
- Changing Lock modes

The *advanced* function covered in this guide is setting audio output mutes.

The switcher is shipped from the factory in Lock mode 2.
Selecting Lock Mode 2 or Toggling between Mode 2 and Mode 0

NOTES:

- If the switcher is in Lock mode 0 or mode 1, this procedure selects mode 2. The Esc, Video, and Audio buttons blink twice.
- If the switcher is in Lock mode 2, this procedure selects mode 0 (unlocks the switcher). The Video and Audio buttons blink twice.

Toggle the lock on or off by pressing and holding the Enter, Video, and Audio buttons simultaneously until the buttons blink (approximately 2 seconds).

Selecting Lock Mode 2 or Toggling between Mode 2 and Mode 1

NOTES:

- If the switcher is in Lock mode 0 or mode 1, this procedure selects mode 2. The Esc, Video, and Audio buttons blink twice.
- If the switcher is in Lock mode 2, this procedure selects mode 1. The Video and Audio buttons blink twice.

Toggle the lock on and off by pressing and holding the Video button and the Audio button simultaneously for approximately 2 seconds.
Remote Control

This section describes using the remote control features of the DTP CrossPoint 4K Series. Topics that are covered include:

- **Selected SIS Commands**
- **Installing and Starting the Control Programs**
- **Accessing the HTML Pages**

### Selected SIS Commands

You can use Simple Instruction Set (SIS) commands for operation and configuration of the switchers (see [SIS Command and Response Table for Matrix Switcher Commands](#) on page 24). You can run these commands from the PC connected to an Ethernet port (item Q or item R on page 9), serial port (item S on page 9), or USB port (item A on page 16) on the switcher.

#### Establishing a Network (Ethernet) Connection

**NOTE:** The first time you connect to the switcher via the LAN port, you may need to change the default settings (IP address, subnet mask, user name, and administrator or user password) of the IPCP controller or switcher.

Establish a network connection as follows:

1. Open a TCP socket to port 23 using the switcher IP address.

   **NOTE:** The factory default IP address is 192.168.254.254.

   The switcher responds with a copyright message including the name, firmware version, and part number of the product, and the current date and time.

   **NOTES:**
   - If the switcher is not password-protected, the device is now ready to accept SIS commands.
   - If the switcher is password-protected, a password prompt appears.

2. If necessary, enter the appropriate password.

   If the password is accepted, the switcher responds with Login User or Login Administrator.

   If the password is not accepted, the Password prompt reappears.
Number of Connections

A switcher can have up to 200 simultaneous TCP connections, including all HTTP sockets and Telnet connections. When the connection limit is reached, the switcher accepts no new connections until some have been closed. No error message or indication is given that the connection limit has been reached. To maximize the performance of your switcher, keep the number of connections low and close unnecessary open sockets.

Establishing a USB Port Connection

A standard USB cable and the Extron DataViewer utility, version 2.0 or newer, can be used for connection to the DTP CrossPoint matrix switcher Configuration port. The USB cable, available at any local electronics store, should be terminated on one end with a mini USB B male connector.

NOTE: Before you use the USB port for the first time, install the USB driver on your computer. The simplest way to do this is to install the Product Configuration Software (see Installing and Starting the Control Program on page 28) and then run the Found New Hardware Wizard.

Host-to-Switcher Instructions

The switcher accepts SIS commands through its serial port, its USB port, or its LAN port. SIS commands consist of one or more characters per command field. They do not require any special characters to begin or end the command character sequence. Each switcher response to an SIS command ends with a carriage return and a line feed (CR/LF = \n), which signals the end of the response character string. A string is one or more characters.

NOTE: The tables that begin on the next page are a partial list of SIS commands. For a complete listing, see the DTP CrossPoint 4K Series User Guide.

Common SIS Command Symbols

The following symbols are used throughout the command and response table, which starts on the next page:

- = Space
- = Carriage return and line feed
- = Carriage return (no line feed)
\| = Pipe (can be used interchangeably with the \n character)
\Esc = Escape key (hex 1B)
\W = Can be used interchangeably with the \Esc character
# SIS Command and Response Table for Matrix Switcher Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>SIS Command (Host to Unit)</th>
<th>Response (Unit to Host)</th>
<th>Additional Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Create ties</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NOTES:</td>
<td>• Commands can be entered back-to-back in a string, with no spaces. For example: 1<em>1!02</em>02$03<em>03%4</em>4$.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The matrix switchers support 1- and 2-digit numeric entries (1<em>1! or 02</em>02%).</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Audio breakaway command functions are dependent on the audio routing selections of the inputs and outputs.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tie input X1 video and audio to output X2</td>
<td>X1*X2!</td>
<td>OutX2<em>InX1</em>All</td>
<td>Tie the video and audio from input X1 to output X2.</td>
</tr>
<tr>
<td>Example:</td>
<td>1*3!</td>
<td>Out03<em>In01</em>All</td>
<td>Tie input 1 to output 3.</td>
</tr>
<tr>
<td>Tie input X1 to output X2, video</td>
<td>X1*X2%</td>
<td>OutX2<em>InX1</em>Vid</td>
<td>Tie input X1 video to output X2. Audio is broken away.</td>
</tr>
<tr>
<td>Example:</td>
<td>7*5%</td>
<td>Out05<em>In07</em>Vid</td>
<td>Tie input 7 video to output 5.</td>
</tr>
<tr>
<td>Tie input X1 to output X2, audio</td>
<td>X1*X2$</td>
<td>OutX2<em>InX1</em>Aud</td>
<td>Tie input X1 audio to output X2. Audio is broken away.</td>
</tr>
<tr>
<td>Example:</td>
<td>2*04$</td>
<td>Out04<em>In02</em>Aud</td>
<td>Tie input 2 audio to output 4.</td>
</tr>
<tr>
<td>Tie input X1 to all outputs</td>
<td>X1*</td>
<td>InX1*All</td>
<td>X1*% and X1*$ are also valid.</td>
</tr>
<tr>
<td>Quick multiple tie</td>
<td>Esd+QX1<em>X2!...X1</em>X2$</td>
<td>Qik</td>
<td>Enter multiple tie commands (!, %, and $) before the $\rightarrow$.</td>
</tr>
<tr>
<td>Read video output tie</td>
<td>X2%</td>
<td>X1$</td>
<td>Video input X1 is tied to output X2. X2$ is also valid for audio.</td>
</tr>
</tbody>
</table>

## Video mutes

<table>
<thead>
<tr>
<th>Command</th>
<th>SIS Command (Host to Unit)</th>
<th>Response (Unit to Host)</th>
<th>Additional Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video only mute</td>
<td>X2*1B</td>
<td>VmtX2*1</td>
<td>Mute output X2 video (sync remains active).</td>
</tr>
<tr>
<td>Video and sync mute</td>
<td>X2*2B</td>
<td>VmtX2*2</td>
<td>Mute output X2 video and sync.</td>
</tr>
<tr>
<td>Video unmute</td>
<td>X2*0B</td>
<td>VmtX2*0</td>
<td>Unmute output X2 (video and sync on).</td>
</tr>
<tr>
<td>Read video mute</td>
<td>X2B</td>
<td>X3</td>
<td>Video input X1 is tied to output X2.</td>
</tr>
<tr>
<td>Global video mute</td>
<td>1*B</td>
<td>Vmt1</td>
<td>Mute all video outputs.</td>
</tr>
<tr>
<td>Global video unmute</td>
<td>0*B</td>
<td>Vmt0</td>
<td>Unmute all video outputs.</td>
</tr>
</tbody>
</table>

**NOTE:**
- X1 = Input number
- X2 = Output number
- X3 = Mute
- 00 – 10 (00 = untied)
- 01 – 08
- 0 = off (unmuted)
- 1 = video muted
- 2 = video and sync muted
### HDCP status

<table>
<thead>
<tr>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>View input HDCP status</td>
</tr>
<tr>
<td>View HDCP status of all inputs</td>
</tr>
<tr>
<td>View output HDCP status</td>
</tr>
<tr>
<td>View HDCP status of all outputs</td>
</tr>
</tbody>
</table>

**Additional Description**

**HDCP status**

- **E** indicates the Host to Unit command.
- **X** indicates the Unit to Host response.
- **I** indicates **Input reports as an HDCP-authorized device** are executed.
- **O** indicates **Execute Auto-Image** is executed.
- **S** indicates **List Digital Sync Validation Processing (DSVP)** is executed.
- **X** indicates **NOTE:**

### Input reports as an HDCP-authorized device

<table>
<thead>
<tr>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDCP-authorized device on</td>
</tr>
<tr>
<td>HDCP-authorized device off</td>
</tr>
<tr>
<td>View HDCP-authorized status</td>
</tr>
</tbody>
</table>

### Execute Auto-Image

<table>
<thead>
<tr>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execute Auto-Image</td>
</tr>
</tbody>
</table>

### List Digital Sync Validation Processing (DSVP)

<table>
<thead>
<tr>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>List sync of all inputs</td>
</tr>
</tbody>
</table>

**Example:**

<table>
<thead>
<tr>
<th>Response Status:</th>
<th>Input:</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 0 1 1 1 0 0 0 0 0</td>
<td>1 2 3 4 5 6 7 8 9 10</td>
</tr>
</tbody>
</table>

**NOTE:**

- **X$I** = Input number 01 – 10
- **X$O** = Output number 01 – 08
- **X$X** = HDCP status (for inputs) 0 = no source connected 1 = source is HDCP compliant 2 = source is not HDCP compliant
- **X$X** = HDCP status (for outputs) 0 = No monitor connected 1 = Monitor connected but does not support HDCP 2 = Monitor connected, supports HDCP, but the video signal is not encrypted 7 = Monitor connected, supports HDCP, and the video signal is encrypted
- **X$X** = HDCP-authorized device 0 = off 1 = on (default)
- **X$X** = Scaled output number 05 through 08
- **X$X** = Signal detection status 0 = no input connected 1 = input connected
## Input audio selection

**Input audio selection**

<table>
<thead>
<tr>
<th>Command</th>
<th>SIS Command</th>
<th>Response</th>
<th>Additional Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input audio selection</td>
<td>Esc I[x1]*[x9]AFMT</td>
<td>Afmt I[x1]*[x9]</td>
<td></td>
</tr>
<tr>
<td><strong>Example:</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>View input audio selection</td>
<td>Esc I[x1]AFMT</td>
<td>x9</td>
<td></td>
</tr>
<tr>
<td>View input audio all selections</td>
<td>Esc IAFMT</td>
<td>x9...x9...x10</td>
<td>Each x9 is the auto, analog, or HDMI selection of an audio input, starting at input 1.</td>
</tr>
</tbody>
</table>

**Auto (0):** Digital audio takes priority over analog audio.

## Group master level (volume and mute)

**NOTES:**
- The DTP CrossPoint 108 has 16 configurable group masters.
- By factory default, group 1 controls the program volume and group 2 controls the mic volume.
- Other group masters (such as mutes) must be preset (have already been created) in the DSP Configurator program to be available as x10s for SIS commands.

<table>
<thead>
<tr>
<th>Command</th>
<th>SIS Command</th>
<th>Response</th>
<th>Additional Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set gain (+) or attenuation (−) dB value</td>
<td>Esc D[x10]*±[x11]GRPM</td>
<td>GrpmD[x10]*[x11]</td>
<td>Specify + for gain or - for attenuation.</td>
</tr>
<tr>
<td><strong>Example:</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Increment dB value</td>
<td>Esc D[x10]*+[x11]GRPM</td>
<td>GrpmD[x10]*[x11]</td>
<td>Increase master x10 by x11.</td>
</tr>
<tr>
<td><strong>Example:</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Decrement dB value</td>
<td>Esc D[x10]*-[x11]GRPM</td>
<td>GrpmD[x10]*[x11]</td>
<td>Decrease master x10 by x11.</td>
</tr>
<tr>
<td>View master value</td>
<td>Esc D[x10]GRPM</td>
<td>x11</td>
<td></td>
</tr>
<tr>
<td>Set mute or unmute</td>
<td>Esc D[x10]*x3GRPM</td>
<td>GrpmD[x10]*x3</td>
<td>Mute (1) or unmute (0) the group.</td>
</tr>
</tbody>
</table>

**NOTE:**
- x10 = Group number
- x11 = Group master value
- dB value in 0.1 increments. Example: x11 = 50 = 5 dB.

### Variable meanings:
- x1 = Input number
- x3 = Mute
- x9 = Input audio source
- x10 = Group number
- x11 = Group master value

x1 = 01 – 10
x3 = 0 = off (unmuted) 1 = on (muted)
x9 = 0 = Auto (see the example above) 2 = Analog (local 2-channel audio)
1 = HDMI (de-embedded digital audio) (default)
x10 = 01 – 16 (can be a user-defined alias enclosed in brackets { })
x11 = 0.1 dB value (see the example above)
<table>
<thead>
<tr>
<th>Command</th>
<th>SIS Command (Host to Unit)</th>
<th>Response (Unit to Host)</th>
<th>Additional Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recall a preset</td>
<td>X13</td>
<td>RprX13</td>
<td>Recall preset X13.</td>
</tr>
<tr>
<td>View video and audio mutes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>View output mutes</td>
<td>Esc VM&lt;-&gt;</td>
<td>X14, X14, ... X14</td>
<td>Each X14 response is the mute status of an output, starting from output 1. Includes outputs 5a, 5b, 6a, and 6b for a total of ten X14s for eight outputs..</td>
</tr>
<tr>
<td>Example:</td>
<td>Esc VM&lt;-&gt;</td>
<td>022 ... 1&lt;-&gt;</td>
<td>Output 1 is unmuted. Audio is muted on outputs 2 and 3, video is muted on output 10.</td>
</tr>
<tr>
<td>Lock (Executive) modes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>NOTE</strong>: See Setting the Front Panel Locks (Executive Modes) on page 20 for more information on the Lock modes.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lock all front panel functions</td>
<td>1X</td>
<td>Exe1&lt;-&gt;</td>
<td>Enable Lock mode 1.</td>
</tr>
<tr>
<td>Lock advanced front panel functions</td>
<td>2X</td>
<td>Exe2&lt;-&gt;</td>
<td>Enable Lock mode 2.</td>
</tr>
<tr>
<td>Unlock all front panel functions</td>
<td>0X</td>
<td>Exe0&lt;-&gt;</td>
<td>Enable Lock mode 0.</td>
</tr>
<tr>
<td>View lock status</td>
<td>X</td>
<td>X15&lt;-&gt;</td>
<td></td>
</tr>
<tr>
<td>Information requests</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Information request</td>
<td>I</td>
<td>DTPCP108&lt;-&gt;</td>
<td></td>
</tr>
<tr>
<td>Request part number</td>
<td>N</td>
<td>60-nnnn-nn&lt;-&gt;</td>
<td>See the Extron website for part number.</td>
</tr>
<tr>
<td>Query firmware version</td>
<td>Q</td>
<td>X15&lt;-&gt;</td>
<td></td>
</tr>
<tr>
<td>Example:</td>
<td>Q</td>
<td>1.23&lt;-&gt;</td>
<td>The factory-installed controller firmware version is 1.23 (sample value only).</td>
</tr>
<tr>
<td><strong>NOTE:</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>X13 = Preset</td>
<td></td>
<td>Ø1 through 32</td>
<td></td>
</tr>
<tr>
<td>X14 = Video and audio mute status</td>
<td></td>
<td>Ø = no mutes</td>
<td>4 = Analog audio</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = video mute</td>
<td>5 = Video and analog audio mute</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 = audio mute</td>
<td>6 = All audio mute</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3 = video and HDMI/SPDIF audio mute</td>
<td>7 = Both video and audio mute</td>
</tr>
<tr>
<td>X15 = Lock mode</td>
<td></td>
<td>Ø = lock mode 0 (unlocked)</td>
<td>1 = lock mode 1</td>
</tr>
<tr>
<td>X16 = Firmware version number to second decimal place (x.xx)</td>
<td></td>
<td></td>
<td>2 = lock mode 2 (default)</td>
</tr>
</tbody>
</table>
Installing and Starting the Control Programs

The following programs are available on the Extron website:

**Digital Signal Processor (DSP) Configurator program** — Required for full operation of switcher DSP functions and to save presets. It also provides some limited control of the switcher non-DSP functions. See the *DTP CrossPoint 4K Series User Guide* and the program Help file for more information.

**Product Configuration Software (PCS)** — Configures the video functions of the switcher, including creating video and audio ties and creating and saving logos. Also provides control of audio line input gain and attenuation and output attenuation, the only audio variables controllable in PCS.

Run either program from a Windows-based computer connected to an Ethernet port (item Q or item R on page 9) or USB port (item A on page 16) on the switcher.

**NOTES:**
- For details on operating the program, see the *DTP CrossPoint 4K Series User Guide*.
- The DSP Configurator program has a software switch that allows you to lock out audio adjustments in the Product Configuration Software, making them unavailable for selection.

**Installing the programs**

The DSP Configurator, version 2.10 or newer, and PCS, version 3.2 or newer are available on the Extron website. Download and install both programs as follows:

**NOTE:** This procedure was written using Microsoft® Windows Explorer®. Depending on the browser you use, some steps or indications may be different.

1. Visit [www.extron.com](http://www.extron.com) and click the **Download** tab (see figure 13, 1).

![Figure 13. Download Center](http://www.extron.com)

2. Click the **Software** link (2).
3. Select the desired software to download and click **Download** (see figure 14, ①).

   **TIP:** Jump to the nearest page of downloads by clicking the desired filtering letter.

   ![Figure 14. Selecting Download](image)

   The **Download Center** dialog box appears (see figure 15).

   ![Figure 15. Download Center Dialog Box](image)

4. Enter the requested personal information (see figure 15, ①).

   **TIP:** Click **Remember Me** to eliminate step 4 in future downloads.

5. Click **Download** to copy the software or firmware to your computer (②). The download warns you about downloads and asks you to confirm it (see figure 16).

   ![Figure 16. Confirmation Dialog Box](image)

6. Click **Run** to confirm that you want to run the installation (see figure 16, ①).

7. Follow the on-screen instructions. The installation program creates the necessary directories and folders and installs the programs.
Starting the Product Configuration Software

1. Click Start > Programs > Extron Electronics > Extron Product Configuration Software > Extron Product Configuration Software.

The Product Configuration Software opens to the Device Discovery screen (see figure 17).

![Device Discovery Screen](image1)

**Figure 17. Device Discovery Screen**

TIP: You can also launch the Product Configuration Software from the DSP Configurator program, **BUT** PCS can be locked out from within DSP.

2. Select (click) your DTP CrossPoint (1) and click **Connect** (2).

**NOTE:** The factory default IP address is 192.168.254.254.

The Product Configuration Software opens (see figure 18). Operate the program as described in the *DTP CrossPoint 4K Series User Guide*, available at [www.extron.com](http://www.extron.com), and the built-in Help file.

![Product Configuration Software](image2)

**Figure 18. Product Configuration Software**
Starting the DSP Configurator Program

The DSP Configurator can connect to the switcher via any rear panel LAN port or the front panel Configuration port.

**NOTE:** Extron recommends connection via an Ethernet LAN port for the DSP Configurator program.

Start the DSP Configurator program, as follows:

1. Click **Start > Programs > Extron Electronics > DSP Configurator > DSP Configurator**. The DSP Configurator Startup screen opens (see figure 19).

![DSP Configurator Screen and Device Selection](image)

**Figure 19.** DSP Configurator Screen and Device Selection

**TIP:** You can also launch the DSP Configurator program from within the Product Configuration Software.

2. If necessary, select the DTP CrossPoint switcher in the drop-down menu and click **OK**.

**TIP:** If you have only DTP CrossPoint switchers of the same model, click **Always perform the selected action** to eliminate step 2 in future startups.

The DSP Configurator program starts in Emulate mode (see **figure 20** on the next page).

**NOTE:** In Emulate mode, changes and settings are stored in the PC and not sent to the switcher until you select Live mode and "push" the settings to the switcher. See the **DTP CrossPoint 4K Series User Guide**.
* The output 1 amplifier block is not present on non-IPCP models.

**Figure 20. DSP Configurator**

**NOTE:** The DSP Configurator has a software lock that protects the complex DSP audio adjustments, making them unavailable for selection in PCS. This protects the DSP settings against inadvertent changes made by the more basic PCS audio adjustment capabilities. This software lock can be overridden, but Extron STRONGLY advises against doing so.

**Accessing the HTML Pages**

**NOTES:**
- If your Ethernet connection to the matrix switcher is unstable, try turning off the proxy server in your Web browser. In Microsoft® Internet Explorer®, click Tools > Internet Options > Connections > LAN Settings, uncheck the Use a proxy server... box, and then click OK.
- For details on operating the switcher via HTML pages, see the “HTML Operation” section in the DTP CrossPoint 4K Series User Guide.

1. Start the Web browser program.
NOTE: For best results, Extron recommends the following browsers and compatibility mode:

- Microsoft Internet Explorer, version 8.0 or newer, with compatibility mode off
- Mozilla® Firefox®, version 6 or newer
- Google Chrome™, version 9 or newer
- Apple® Safari®, version 4 or newer

2. Click in the Address field and enter the IP address.

3. Press the keyboard <Enter> key. The switcher checks whether it is password-protected.

   **If the switcher is not password-protected,** the switcher downloads the HTML start-up page. The switcher is ready for operation via HTML remote control.

   **If the switcher is password-protected,** the switcher downloads the Authentication Required dialog box (see figure 21).

   ![Figure 21. Authentication Required Dialog Box](image)

4. Enter the appropriate user name and administrator or user password in the Password field and click OK.

   The switcher downloads the HTML start-up page (see figure 22 on the next page). The switcher is ready for operation via HTML remote control.
Figure 22. HTML Startup Page, Shown in Google Chrome
Extron Warranty

Extron Electronics warrants this product against defects in materials and workmanship for a period of three years from the date of purchase. In the event of malfunction during the warranty period attributable directly to faulty workmanship and/or materials, Extron Electronics will, at its option, repair or replace said products or components, to whatever extent it shall deem necessary to restore said product to proper operating condition, provided that it is returned within the warranty period, with proof of purchase and description of malfunction to:

**USA, Canada, South America, and Central America:**
Extron Electronics
1230 South Lewis Street
Anaheim, CA 92805
U.S.A.

**Europe and Africa:**
Extron Europe
Hanzeboulevard 10
3825 PH Amersfoort
The Netherlands

**Asia:**
Extron Asia
135 Joo Seng Road, #04-01
PM Industrial Bldg.
Singapore 368363
Singapore

**Japan:**
Extron Electronics, Japan
Kyodo Building, 16 Ichibancho
Chiyoda-ku, Tokyo 102-0082
Japan

**China:**
Extron China
686 Ronghua Road
Songjiang District
Shanghai 201611
China

**Middle East:**
Extron Middle East
Dubai Airport Free Zone
F13, PO Box 293666
United Arab Emirates, Dubai

This Limited Warranty does not apply if the fault has been caused by misuse, improper handling care, electrical or mechanical abuse, abnormal operating conditions, or if modifications were made to the product that were not authorized by Extron.

**NOTE:** If a product is defective, please call Extron and ask for an application engineer to receive an RA (return authorization) number. This will begin the repair process.

**USA:** 714.491.1500 or 800.633.9876
**Europe:** 31.33.453.4040
**Asia:** 65.6383.4400
**Japan:** 81.3.3511.7655

Units must be returned insured, with shipping charges prepaid. If not insured, you assume the risk of loss or damage during shipment. Returned units must include the serial number and a description of the problem, as well as the name of the person to contact in case there are any questions.

Extron Electronics makes no further warranties either expressed or implied with respect to the product and its quality, performance, merchantability, or fitness for any particular use. In no event will Extron Electronics be liable for direct, indirect, or consequential damages resulting from any defect in this product even if Extron Electronics has been advised of such damage.

Please note that laws vary from state to state and country to country, and that some provisions of this warranty may not apply to you.